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Q.1 A and B entered into a partnership investing ₹17,000 and ₹16,000, respectively. After
3 months, A withdrew ₹5,000 while B invested ₹5,000 more. After 3 more months C
joins the business with a capital of ₹35,000. The share of B exceeds that of C, out of a
total profit of ₹95,546 after one year by:

Ans A. ₹4,165

B. ₹4,480

C. ₹4,332

D. ₹4,257

Question Type : MCQ
Question ID : 441009896517
Option 1 ID : 4410093540138
Option 2 ID : 4410093540141
Option 3 ID : 4410093540140
Option 4 ID : 4410093540139

Status : Not Answered
Chosen Option : --

Q.2 A bus is scheduled to cover 180 km in 3 hours. Due to heavy initial traffic, it runs at a
speed 15 km/hr less than the scheduled speed for the first half distance to be
covered and at a speed 15 km/hr more than the scheduled speed for the remaining
distance. How much more time will the bus take compared to the scheduled time to
complete the journey?

Ans A. 12 minutes

B. 21 minutes

C. 15 minutes

D. 18 minutes

Question Type : MCQ
Question ID : 4410091232600
Option 1 ID : 4410094864228
Option 2 ID : 4410094864231
Option 3 ID : 4410094864229
Option 4 ID : 4410094864230

Status : Answered
Chosen Option : C

Q.3 A cistern can be filled by two pipes, A and B, in 2 hours and 4 hours, respectively,
while a third pipe, C, can empty the full cistern in 8 hours. If all three pipes are
opened simultaneously, how long will it take to fill the cistern?

Ans A. 1 hour 54 minutes

B. 1 hour 36 minutes

C. 1 hour 45 minutes

D. 1 hour 50 minutes

Question Type : MCQ
Question ID : 441009900037
Option 1 ID : 4410093554218
Option 2 ID : 4410093554219
Option 3 ID : 4410093554220
Option 4 ID : 4410093554221

Status : Answered
Chosen Option : C
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Q.4 Using the empirical relationship, find the mode if the mean is 40 and the median is
42.

Ans A. 44

B. 46

C. 48

D. 42

Question Type : MCQ
Question ID : 4410091836843
Option 1 ID : 4410097241007
Option 2 ID : 4410097241008
Option 3 ID : 4410097241009
Option 4 ID : 4410097241006

Status : Answered
Chosen Option : A

Q.5 ଜଣେ ବ୍ୟାଟସମ୍ୟାନଙ୍କ ଦ୍ୱାରା ସ୍କୋର କରାଯାଇଥିବା 21 ଟି ମ୍ୟାଚରେ ହାରାହାରି ରନ 45 ଅଟେ । ପରବର୍ତ୍ତୀ 10
ଟି ମ୍ୟାଚରେ ସେହି ବ୍ୟାଟସମ୍ୟାନ ହାରାହାରି 14 ରନ ସ୍କୋର କରିଥିଲେ । ସମସ୍ତ 31 ଟି ମ୍ୟାଚରେ ତାଙ୍କର
ହାରାହାରି (ରନ ରେ) ନିର୍ଣ୍ଣୟ କର ।

Ans A. 35

B. 36

C. 34

D. 37

Question Type : MCQ
Question ID : 441009988308
Option 1 ID : 4410093905521
Option 2 ID : 4410093905523
Option 3 ID : 4410093905522
Option 4 ID : 4410093905524

Status : Answered
Chosen Option : C

Q.6 The average of 10 numbers is 15. The average of 8 of these numbers is 13. The
average of the remaining two numbers is:

Ans A. 23

B. 25

C. 24

D. 22

Question Type : MCQ
Question ID : 441009272594
Option 1 ID : 4410091058923
Option 2 ID : 4410091058926
Option 3 ID : 4410091058924
Option 4 ID : 4410091058925

Status : Answered
Chosen Option : B
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Q.7 96% of the population of a village is 23,760. The total population of the village is:

Ans A. 33,006

B. 24,750

C. 25,686

D. 26,390

Question Type : MCQ
Question ID : 441009857534
Option 1 ID : 4410093383111
Option 2 ID : 4410093383108
Option 3 ID : 4410093383109
Option 4 ID : 4410093383110

Status : Not Answered
Chosen Option : --

Q.8 If x + y + z = 12, and x2 + y2 + z2 = 44, then find the value of xy + yz + xz.

Ans A. 45

B. 60

C. 55

D. 50

Question Type : MCQ
Question ID : 441009217988
Option 1 ID : 441009855884
Option 2 ID : 441009855887
Option 3 ID : 441009855886
Option 4 ID : 441009855885

Status : Not Answered
Chosen Option : --

Q.9 4 cm ବ୍ୟାସାର୍ଦ୍ଧ ଓ 12 cm ଉଚ୍ଚତା ବିଶିଷ୍ଟ ସିଲିଣ୍ଡର ଆକୃତିର 21 ଟି ପେନ ହୋଲ୍ଡର ତିଆରି କରିବା ପାଇଁ
କେତେ କାର୍ଡବୋର୍ଡ ଆବଶ୍ୟକ ହେବ (π = 3.14 ବ୍ୟବହାର କର)?

Ans A. 7426.57 cm2

B. 7518.92 cm2

C. 7668.05 cm2

D. 7385.28 cm2

Question Type : MCQ
Question ID : 441009293813
Option 1 ID : 4410091142115
Option 2 ID : 4410091142116
Option 3 ID : 4410091142117
Option 4 ID : 4410091142114

Status : Not Answered
Chosen Option : --
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Q.10 ସଚିନ 40 km/hr ବେଗରେ କ୍ୟାବରେ ଅଫି ସକୁ ଯାଆନ୍ତି ଏବଂ ଫେରିବା ସମୟରେ ସେ ମେଟ୍ରୋରେ ଯାତ୍ରା
କରନ୍ତି । ଫେରିବା ଯାତ୍ରା ପାଇଁ  ତାଙ୍କର ବେଗ 50 km/hr ଅଟେ । ସମଗ୍ର ଯାତ୍ରା ପାଇଁ  ତାଙ୍କର ହାରାହାରି ବେଗ
ନିର୍ଣ୍ଣୟ କର । (ଦଶମିକ ଦୁଇ ସ୍ଥାନ ପର୍ଯ୍ୟନ୍ତ ପୂର୍ଣ୍ଣାଙ୍କିତ କରନ୍ତୁ)

Ans A. 42.88 km/hr

B. 44.44 km/hr

C. 43.75 km/hr

D. 45.45 km/hr

Question Type : MCQ
Question ID : 441009280871
Option 1 ID : 4410091101405
Option 2 ID : 4410091101403
Option 3 ID : 4410091101404
Option 4 ID : 4410091101402

Status : Not Answered
Chosen Option : --

Q.11 If 25% of k is 10 less than 3600% of 10, then k is:

Ans A. 1380

B. 1440

C. 1400

D. 1360

Question Type : MCQ
Question ID : 4410091107656
Option 1 ID : 4410094367619
Option 2 ID : 4410094367621
Option 3 ID : 4410094367618
Option 4 ID : 4410094367620

Status : Answered
Chosen Option : D

Q.12 ଜଣେ ଦୋକାନୀ ଗୋଟେ ସାମଗ୍ରୀକୁ ଏହାର ଚିହ୍ନିତ ମୂଲ୍ୟ ଉପରେ 80% ଏବଂ 66% ର ଦୁଇଟି କ୍ରମିକ ରିହାତି
ଦେବା ପରେ ₹751.4 ରେ ବିକ୍ରି କରନ୍ତି । ଯଦି ସେ କୌଣସି ରିହାତି ଦେଇନଥାନ୍ତେ, ତେବେ ସେ 70 % ଲାଭ
ଅର୍ଜନ କରିଥାନ୍ତେ । ସାମଗ୍ରୀର କ୍ରୟ ମୂଲ୍ୟ କେତେ (₹ ରେ) ଅଟେ?

Ans A. 6,476

B. 6,500

C. 6,520

D. 6,542

Question Type : MCQ
Question ID : 441009915809
Option 1 ID : 4410093617489
Option 2 ID : 4410093617487
Option 3 ID : 4410093617488
Option 4 ID : 4410093617490

Status : Not Answered
Chosen Option : --

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.13 ଜଣେ ଦୋକାନୀ 10 ଟି ନୋଟବୁକ ₹160 ରେ କିଣି ପ୍ରତ୍ୟେକ ନୋଟବୁକକୁ ₹14 ରେ ବିକ୍ରି କରନ୍ତି । ଲାଭ କିମ୍ବା
କ୍ଷତି ପ୍ରତିଶତ ନିର୍ଣ୍ଣୟ କର ।

Ans A. 10% କ୍ଷତି

B. 10% ଲାଭ

C. 12.5% ଲାଭ

D. 12.5% କ୍ଷତି

Question Type : MCQ
Question ID : 4410091593723
Option 1 ID : 4410096295220
Option 2 ID : 4410096295218
Option 3 ID : 4410096295219
Option 4 ID : 4410096295221

Status : Answered
Chosen Option : A

Q.14 ଯଦି ସମାନ ସୁଧ ହାରରେ, ସମାନ ମୂଳଧନ ଉପରେ, 2 ବର୍ଷରେ ସରଳ ସୁଧ ₹68 ହୁଏ ଏବଂ ବାର୍ଷିକ ଭାବେ
ଚକ୍ରବୃଦ୍ଧି ହେଉଥିବା ବାର୍ଷିକ ଚକ୍ରବୃଦ୍ଧି ସୁଧ ₹70 ହୁଏ, ତେବେ ମୂଳଧନ (₹ରେ) କେତେ?

Ans A. 573

B. 582

C. 578

D. 571

Question Type : MCQ
Question ID : 441009572222
Option 1 ID : 4410092244009
Option 2 ID : 4410092244011
Option 3 ID : 4410092244008
Option 4 ID : 4410092244010

Status : Answered
Chosen Option : C

Q.15 Find the 4th proportional to 5, 17 and 35.

Ans A. 119

B. 117

C. 113

D. 115

Question Type : MCQ
Question ID : 4410091430978
Option 1 ID : 4410095652227
Option 2 ID : 4410095652226
Option 3 ID : 4410095652224
Option 4 ID : 4410095652225

Status : Answered
Chosen Option : B
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Q.16 ଏକ ପମ୍ପ ଦୁଇ ଘଣ୍ଟାରେ ଏକ ଟାଙ୍କିକୁ ପେଟ୍ରୋଲରେ ପୂର୍ଣ୍ଣ କରିପାରିବ । ଲିକ ଯୋଗୁଁ , ଟାଙ୍କି  ପୂର୍ଣ୍ଣ ହେବା ପାଇଁ
ଅଧିକ ଦୁଇ ଘଣ୍ଟା ତିରିଶ ମିନିଟ ସମୟ ଲାଗିଥାଏ । ଟାଙ୍କିର ସମସ୍ତ ପେଟ୍ରୋଲକୁ ଲିକଟି କେତେ ସମୟରେ
ନିଷ୍କାସନ କରିପାରିବ?

Ans A. 10 ଘଣ୍ଟା

B. 8 ଘଣ୍ଟା

C. 9 ଘଣ୍ଟା

D. 7 ଘଣ୍ଟା

Question Type : MCQ
Question ID : 441009212095
Option 1 ID : 441009832747
Option 2 ID : 441009832746
Option 3 ID : 441009832748
Option 4 ID : 441009832749

Status : Answered
Chosen Option : B

Q.17
2473

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009602164
Option 1 ID : 4410092363775
Option 2 ID : 4410092363773
Option 3 ID : 4410092363776
Option 4 ID : 4410092363774

Status : Not Answered
Chosen Option : --

Q.18

Ans A. 10.38

B. 4.16

C. 14.51

D. 14.01

Question Type : MCQ
Question ID : 441009575800
Option 1 ID : 4410092258321
Option 2 ID : 4410092258323
Option 3 ID : 4410092258322
Option 4 ID : 4410092258320

Status : Answered
Chosen Option : D
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Q.19 The fourth proportional to k, 3k, and 7k is 63. Find the value of k.

Ans A. 7

B. 3

C. 4

D. 2

Question Type : MCQ
Question ID : 4410091836779
Option 1 ID : 4410097240757
Option 2 ID : 4410097240755
Option 3 ID : 4410097240756
Option 4 ID : 4410097240754

Status : Answered
Chosen Option : B

 

Q.20

Ans A. 1.1180

B. 0.543

C. 0.866

D. 0.707

Question Type : MCQ
Question ID : 441009273132
Option 1 ID : 4410091061078
Option 2 ID : 4410091061075
Option 3 ID : 4410091061077
Option 4 ID : 4410091061076

Status : Answered
Chosen Option : A

Q.21 Which of the following Amendments to the Indian Constitution introduced the
Fundamental Duties of the citizens?

Ans A. 45th Amendment

B. 44th Amendment

C. 43rd Amendment

D. 42nd Amendment

Question Type : MCQ
Question ID : 441009870529
Option 1 ID : 4410093435071
Option 2 ID : 4410093435070
Option 3 ID : 4410093435069
Option 4 ID : 4410093435068

Status : Answered
Chosen Option : C

Section : General Studies
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Q.22 Fakir Mohan Senapati is regarded as the father of which of the following movements
or identities?

Ans A. Odia nationalism

B. Indian National Congress

C. Bengali renaissance

D. Indian industrialization

Question Type : MCQ
Question ID : 441009931793
Option 1 ID : 4410093680983
Option 2 ID : 4410093680982
Option 3 ID : 4410093680984
Option 4 ID : 4410093680985

Status : Answered
Chosen Option : A

Q.23 କେଉଁ  ଓଡ଼ିଆ କବି 'ପଲ୍ଲୀ କବି' ନାମରେ ପରିଚିତ?

Ans A. ଫକିର ମୋହନ ସେନାପତି

B. ମଧୁସୂଦନ ରାଓ

C. ନନ୍ଦ କିଶୋର ବଳ

D. ଗୋପବନ୍ଧୁ ଦାସ

Question Type : MCQ
Question ID : 4410091424362
Option 1 ID : 4410095626276
Option 2 ID : 4410095626275
Option 3 ID : 4410095626277
Option 4 ID : 4410095626278

Status : Answered
Chosen Option : C

Q.24 What was the literacy rate of females in India as per the Census of India, 2011?

Ans A. 65.46%

B. 50.6%

C. 55.77 %

D. 59.7%

Question Type : MCQ
Question ID : 441009866841
Option 1 ID : 4410093420396
Option 2 ID : 4410093420397
Option 3 ID : 4410093420399
Option 4 ID : 4410093420398

Status : Answered
Chosen Option : A
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Q.25 ନିମ୍ନଲିଖିତ କେଉଁ  ପଦ ଜାତି, ଲିଙ୍ଗ କିମ୍ବା ଆୟ ନିର୍ବିଶେଷରେ ସମସ୍ତଙ୍କ ପାଇଁ  ସମାନ ସୁଯୋଗ ସୁନିଶ୍ଚିତ କରିବାକୁ
ବୁଝାଏ?

Ans A. ଧାରଣୀୟତା (Sustainability)

B. ଉତ୍ପାଦକତା (Productivity)

C. ସମାନତା (Equality)

D. ନିରପେକ୍ଷତା (Equity)

Question Type : MCQ
Question ID : 441009510668
Option 1 ID : 4410091997832
Option 2 ID : 4410091997833
Option 3 ID : 4410091997831
Option 4 ID : 4410091997830

Status : Answered
Chosen Option : C

Q.26 Which of the following is the second planet from the Sun and is often referred to as
Earth's twin?

Ans A. Mercury

B. Mars

C. Venus

D. Jupiter

Question Type : MCQ
Question ID : 4410091460291
Option 1 ID : 4410095769337
Option 2 ID : 4410095769339
Option 3 ID : 4410095769338
Option 4 ID : 4410095769340

Status : Answered
Chosen Option : C

Q.27 ରାଜ୍ୟସ୍ତରୀୟ କାର୍ଯ୍ୟକ୍ରମ ମତ୍ସ୍ୟ-ପ୍ରାଣୀ ସମାବେଶ ଓଡ଼ିଶା 2026 ନିମ୍ନଲିଖିତ କେଉଁ  କ୍ଷେତ୍ରରେ ଆଧୁନିକ ପଦ୍ଧତିର
ପ୍ରଦର୍ଶନ କରେ?

Ans A. ମୃତ୍ତିକା ସଂରକ୍ଷଣ ଏବଂ ବନୀକରଣ

B. ପଶୁପାଳନ ଏବଂ ମତ୍ସ୍ୟଚାଷ

C. ପର୍ଯ୍ୟଟନ ଏବଂ ହସ୍ତଶିଳ୍ପ

D. ଖଣି ଓ ଶିଳ୍ପ

Question Type : MCQ
Question ID : 4410091863086
Option 1 ID : 4410097342545
Option 2 ID : 4410097342542
Option 3 ID : 4410097342544
Option 4 ID : 4410097342543

Status : Answered
Chosen Option : B
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Q.28 During the February 2026 Budget, the Odisha Government under "Mission PoWaR"
announced to ensure universal access to basic amenities. Which three defined
principles serve as the foundation for its implementation?

Ans A. Transparency, Accountability, and Participation

B. Efficiency, Equity, and Effectiveness

C. Speed, Scale, and Standard

D. Cost, Quality, and Sustainability

Question Type : MCQ
Question ID : 4410091848870
Option 1 ID : 4410097287714
Option 2 ID : 4410097287713
Option 3 ID : 4410097287711
Option 4 ID : 4410097287712

Status : Not Answered
Chosen Option : --

Q.29 ଉଦ୍ଭିଦର ଆଲୋକ ସଂଶ୍ଳେଷଣ ପାଇଁ  କେଉଁ  ବର୍ଣ୍ଣକଣା ଆବଶ୍ୟକ ହୋଇଥାଏ ?

Ans A. କ୍ଲୋରୋଫି ଲ

B. କେରାଟିନ

C. ହିମୋଗ୍ଲୋବିନ

D. ମେଲାନିନ

Question Type : MCQ
Question ID : 4410091454189
Option 1 ID : 4410095745066
Option 2 ID : 4410095745068
Option 3 ID : 4410095745065
Option 4 ID : 4410095745067

Status : Answered
Chosen Option : B

Q.30 ପ୍ରୋପେନ (C3H8) କେଉଁ  ପ୍ରକାରର କାର୍ବନ ଯୌଗିକ ଅଟେ?

Ans A. ବହୁପରିପୃକ୍ତ ଯୌଗିକ (Polyunsaturated compounds)

B. ଏରୋମାଟିକ ଯୌଗିକ (Aromatic compounds)

C. ପରିପୃକ୍ତ ଯୌଗିକ (Saturated compounds)

D. ଅପରିପୃକ୍ତ ଯୌଗିକ (Unsaturated compounds)

Question Type : MCQ
Question ID : 4410091435167
Option 1 ID : 4410095669203
Option 2 ID : 4410095669201
Option 3 ID : 4410095669202
Option 4 ID : 4410095669200

Status : Answered
Chosen Option : B
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Q.31 The sweet water lake Ansupa is primarily situated within which district of Odisha?

Ans A. Cuttack

B. Sambalpur

C. Ganjam

D. Puri

Question Type : MCQ
Question ID : 441009938776
Option 1 ID : 4410093708787
Option 2 ID : 4410093708788
Option 3 ID : 4410093708786
Option 4 ID : 4410093708785

Status : Answered
Chosen Option : A

Q.32 Which classical dance form is associated with Vaishnavite religious traditions of
Assam?

Ans A. Kuchipudi

B. Sattriya

C. Kathakali

D. Odissi

Question Type : MCQ
Question ID : 4410091847993
Option 1 ID : 4410097284259
Option 2 ID : 4410097284256
Option 3 ID : 4410097284257
Option 4 ID : 4410097284258

Status : Answered
Chosen Option : B

Q.33 ନଭେମ୍ବର 2025 ରେ ଅଷ୍ଟ୍ରେଲିଆ ଏବଂ ଇଣ୍ଡୋନେସିଆ କେଉଁ  ଉଦ୍ଦେଶ୍ୟ ପାଇଁ  ଏକ ନୂତନ ଦ୍ୱିପାକ୍ଷିକ ଚୁକ୍ତି
ସ୍ୱାକ୍ଷର କରିଥିଲେ?

Ans A. ସାମୁଦ୍ରିକ ବାଣିଜ୍ୟ ସହଯୋଗକୁ ପ୍ରୋତ୍ସାହିତ କରିବା

B. ପରିବେଶଗତ ପ୍ରତ୍ୟାସ୍ଥିତା ପ୍ରୟାସକୁ ଆଗକୁ ବଢାଇବା

C. ସାଧାରଣ ସୁରକ୍ଷା ସହଯୋଗ ବୃଦ୍ଧି କରିବା

D. ସାଂସ୍କୃ ତିକ ଓ ଶିକ୍ଷାଗତ ସମ୍ପର୍କ ବିସ୍ତାର କରିବା

Question Type : MCQ
Question ID : 4410091539673
Option 1 ID : 4410096082026
Option 2 ID : 4410096082027
Option 3 ID : 4410096082025
Option 4 ID : 4410096082028

Status : Answered
Chosen Option : A
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Q.34 During which months does Odisha experience the majority of its annual rainfall due
to the southwest monsoon?

Ans A. January to March

B. June to September

C. October to December

D. April to June

Question Type : MCQ
Question ID : 4410091338547
Option 1 ID : 4410095286260
Option 2 ID : 4410095286262
Option 3 ID : 4410095286263
Option 4 ID : 4410095286261

Status : Answered
Chosen Option : B

Q.35 Which year saw the commencement of Project Tiger, a wildlife conservation initiative
by the Indian government that aims to protect the country's dwindling tiger
population?

Ans A. 1973

B. 1976

C. 1971

D. 1969

Question Type : MCQ
Question ID : 4410091448755
Option 1 ID : 4410095723474
Option 2 ID : 4410095723475
Option 3 ID : 4410095723473
Option 4 ID : 4410095723472

Status : Answered
Chosen Option : A

Q.36 ସେପ୍ଟେମ୍ବର 2025 ସୁଦ୍ଧା ଦିଲ୍ଲୀ (NCT) ରେ କେଉଁ  ଦଳ ଶାସନ କ୍ଷମତାରେ ଅଛି ଏବଂ କିଏ ମୁଖ୍ୟମନ୍ତ୍ରୀ ଅଟନ୍ତି?

Ans A. ସମାଜବାଦୀ ପାର୍ଟି, ଅଖି ଳେଶ ଯାଦବ

B. ଭାରତୀୟ ଜନତା ପାର୍ଟି, ରେଖା ଗୁପ୍ତା

C. ଭାରତୀୟ ଜାତୀୟ କଂଗ୍ରେସ, ଅଳକା ଲାମ୍ବା

D. ଆମ ଆଦମୀ ପାର୍ଟି, ଆତିଶୀ ମାର୍ଲେନା

Question Type : MCQ
Question ID : 4410091309368
Option 1 ID : 4410095169113
Option 2 ID : 4410095169111
Option 3 ID : 4410095169112
Option 4 ID : 4410095169110

Status : Answered
Chosen Option : D
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Q.37 କିଏ ଏତମାଦୁ-ଦୌଲା (Itmad-ud-Daulah) ଙ୍କ ସମାଧି ନିର୍ମାଣ କରିଥିଲେ?

Ans A. ଆକବର

B. ରଜିୟା ସୁଲତାନ

C. ନୂର ଜହାଁ

D. ମହମ୍ମଦ ବିନ ତୁ ଘଲକ

Question Type : MCQ
Question ID : 441009892970
Option 1 ID : 4410093525951
Option 2 ID : 4410093525950
Option 3 ID : 4410093525952
Option 4 ID : 4410093525953

Status : Answered
Chosen Option : D

Q.38 The Khelo India Beach Games 2026 were held at which location?

Ans A. Calangute Beach, Goa

B. Ghoghla Beach, Diu

C. Kovalam Beach, Kerala

D. Marina Beach, Chennai

Question Type : MCQ
Question ID : 4410091840942
Option 1 ID : 4410097256979
Option 2 ID : 4410097256978
Option 3 ID : 4410097256980
Option 4 ID : 4410097256977

Status : Answered
Chosen Option : C

Q.39 ଉତ୍ତର ସରକାର (Northern Circar) ନିମ୍ନଲିଖିତ କେଉଁ  ରାଜ୍ୟର ଉପକୂଳରେ ଅବସ୍ଥିତ?

Ans A. ପଶ୍ଚିମବଙ୍ଗ ଓ ଆସାମ

B. ବିହାର ଓ ପଶ୍ଚିମବଙ୍ଗ

C. ଆନ୍ଧ୍ରପ୍ରଦେଶ ଓ ଓଡିଶା

D. ତାମିଲନାଡୁ  ଓ କେରଳ

Question Type : MCQ
Question ID : 441009999568
Option 1 ID : 4410093950113
Option 2 ID : 4410093950114
Option 3 ID : 4410093950115
Option 4 ID : 4410093950116

Status : Answered
Chosen Option : B
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Q.40 ଫେବୃଆରୀ 2026 ରେ କେଉଁ  ସଂସ୍ଥା ଓଡ଼ିଶାର ଚାନ୍ଦିପୁ ରଠାରୁ  ସଲିଡ ଫୁଏଲ ଡକ୍ଟେଡ ରାମଜେଟ ବା Solid
Fuel Ducted Ramjet (SFDR) ଟେକ୍ନୋଲୋଜିର ପରୀକ୍ଷଣ କରିଥିଲା?

Ans A. ଭାରତ ଇଲେକଟ୍ରୋନିକ୍ସ ଲିମିଟେଡ

B. ଭାରତୀୟ ମହାକାଶ ଗବେଷଣା ସଂଗଠନ

C. ପ୍ରତିରକ୍ଷା ଗବେଷଣା ଏବଂ ବିକାଶ ସଂଗଠନ

D. ହିନ୍ଦୁସ୍ତାନ ଏରୋନଟିକ୍ସ ଲିମିଟେଡ

Question Type : MCQ
Question ID : 4410091854286
Option 1 ID : 4410097308752
Option 2 ID : 4410097308753
Option 3 ID : 4410097308751
Option 4 ID : 4410097308750

Status : Answered
Chosen Option : B

Q.41 Which institution was set up during the Swadeshi movement for promoting national
education?

Ans A. Aligarh Muslim University

B. National Council of Education

C. St. Stephen’s College

D. Banaras Hindu University

Question Type : MCQ
Question ID : 441009966447
Option 1 ID : 4410093818983
Option 2 ID : 4410093818984
Option 3 ID : 4410093818986
Option 4 ID : 4410093818985

Status : Answered
Chosen Option : A

Q.42 The Election Commission of India functions under which Article of the Constitution?

Ans A. Article 76

B. Article 280

C. Article 148

D. Article 324

Question Type : MCQ
Question ID : 441009501350
Option 1 ID : 4410091960571
Option 2 ID : 4410091960570
Option 3 ID : 4410091960572
Option 4 ID : 4410091960573

Status : Answered
Chosen Option : C
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Q.43 ନିମ୍ନଲିଖିତ କେଉଁ  ବର୍ଷରେ ହଲବା ବିଦ୍ରୋହ ଆରମ୍ଭ ହୋଇଥିଲା?

Ans A. 1774

B. 1785

C. 1829

D. 1811

Question Type : MCQ
Question ID : 441009822201
Option 1 ID : 4410093242920
Option 2 ID : 4410093242919
Option 3 ID : 4410093242921
Option 4 ID : 4410093242918

Status : Answered
Chosen Option : A

Q.44 ନାଗରିକତା (ସଂଶୋଧନ) ଅଧିନିୟମ, 2019 ଅନୁଯାୟୀ ପାକିସ୍ତାନ, ବାଂଲାଦେଶ ଏବଂ ଆଫଗାନିସ୍ତାନରୁ  ଆସି
31 ଡିସେମ୍ବର 2014 ସୁଦ୍ଧା କିମ୍ବା ତା’ ପୂର୍ବରୁ  ଭାରତରେ ପ୍ରବେଶ କରିଥିବା ନିମ୍ନଲିଖିତ କେଉଁ  ଧାର୍ମିକ ସଂପ୍ରଦାୟର
ବ୍ୟକ୍ତିବିଶେଷଙ୍କୁ ନାଗରିକତା ପ୍ରଦାନ ପାଇଁ  ବ୍ୟବସ୍ଥା ରହିଛି?

Ans A. ହିନ୍ଦୁ, ମୁସଲମାନ, ବୌଦ୍ଧ, ଜୈନ ଏବଂ ଖ୍ରୀଷ୍ଟିଆନ

B. ହିନ୍ଦୁ, ଶିଖ, ବୌଦ୍ଧ, ଜୈନ, ପାର୍ସୀ ଏବଂ ଖ୍ରୀଷ୍ଟିଆନ

C. ହିନ୍ଦୁ, ମୁସଲମାନ, ଜୈନ ଏବଂ ଶିଖ

D. ଶିଖ, ମୁସଲମାନ, ପାର୍ସୀ, ବୌଦ୍ଧ ଏବଂ ଖ୍ରୀଷ୍ଟିଆନ

Question Type : MCQ
Question ID : 4410091443551
Option 1 ID : 4410095702731
Option 2 ID : 4410095702730
Option 3 ID : 4410095702733
Option 4 ID : 4410095702732

Status : Answered
Chosen Option : A

Q.45 ଯେତେବେଳେ ଏକ ବସ୍ତୁ  ସ୍ଥିର ବେଗରେ ଏକ ବୃତ୍ତାକାର ପଥରେ ଗତି କରେ, ସେତେବେଳେ ତାହା କେଉଁ  ଗତି
ଭାବରେ ଜଣାଶୁଣା?

Ans A. ତ୍ୱରାନ୍ୱି ତ ସରଳ ରୈଖି କ ଗତି

B. ଅସମ ଗତି

C. ସମ ରୈଖି କ ଗତି

D. ସମବୃତ୍ତିୟ ଗତି

Question Type : MCQ
Question ID : 4410091445108
Option 1 ID : 4410095709024
Option 2 ID : 4410095709022
Option 3 ID : 4410095709021
Option 4 ID : 4410095709023

Status : Not Answered
Chosen Option : --

Section : English
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Q.46 Choose the correct indirect speech form of the given sentence.

He said, “Had I known about the meeting, I would have attended it.”

Ans A. He said that if he had known about the meeting, he have attended it.

B. He said that had I known about the meeting, I would have attended it.

C. He said that had he known about the meeting, he would have attended it.

D. He said that if he knew about the meeting, he would attend it.

Question Type : MCQ
Question ID : 4410091825643
Option 1 ID : 4410097196858
Option 2 ID : 4410097196861
Option 3 ID : 4410097196859
Option 4 ID : 4410097196860

Status : Not Answered
Chosen Option : --

Q.47 Select the synonym of the underlined word in the given sentence.

After the news broke, a group went on a rampage through the streets, causing chaos.

Ans A. nostalgia

B. frenzy

C. wry

D. concord

Question Type : MCQ
Question ID : 441009889357
Option 1 ID : 4410093511385
Option 2 ID : 4410093511382
Option 3 ID : 4410093511384
Option 4 ID : 4410093511383

Status : Not Answered
Chosen Option : --

Q.48 Select the most appropriate option to substitute the underlined word segment in the
given sentence.

He is working as a person who studies human societies in one of the NGOs.

Ans A. Archaeologist

B. Anthropologist

C. Sociologist

D. Psychologist

Question Type : MCQ
Question ID : 4410091817361
Option 1 ID : 4410097164865
Option 2 ID : 4410097164864
Option 3 ID : 4410097164862
Option 4 ID : 4410097164863

Status : Not Answered
Chosen Option : --
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Q.49 Identify the segment that contains an error.

Although I studied hard for the exam, I felt nervous because the questions were
difficult. Whereas, I remained calm and completed the test on time.

Ans A. Whereas, I remained calm

B. and completed the test on time

C. Although I studied hard for the exam,

D. I felt nervous because the questions were difficult

Question Type : MCQ
Question ID : 4410091830412
Option 1 ID : 4410097215629
Option 2 ID : 4410097215630
Option 3 ID : 4410097215627
Option 4 ID : 4410097215628

Status : Not Answered
Chosen Option : --

Q.50 Identify the error in the use of tense form and indicate the correct form of them in the
following sentence:

The police/ has not arrested/ the thief so far/ and the residents are displeased.

Ans A. is not arresting

B. have not been arrested

C. have not arrested

D. has not been arrested

Question Type : MCQ
Question ID : 441009384064
Option 1 ID : 4410091501909
Option 2 ID : 4410091501907
Option 3 ID : 4410091501906
Option 4 ID : 4410091501908

Status : Not Answered
Chosen Option : --

Q.51 Select the option that identifies an error in the sentence and provides its correct
replacement.

The children enjoyed playing on the beach. They finished sandcastles, swam in the
sea, and collected shells.

Ans A. Replace “The children enjoyed playing” with “The children gathered playing”

B. Replace “They finished sandcastles” with “They built sandcastles”

C. Replace “and collected shells” with “and developed shells”

D. Replace “swam in the sea” with “earned in the sea”

Question Type : MCQ
Question ID : 4410091830423
Option 1 ID : 4410097215671
Option 2 ID : 4410097215672
Option 3 ID : 4410097215674
Option 4 ID : 4410097215673

Status : Not Answered
Chosen Option : --
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Q.52 A statement divided into different segments is given. The first segment is fixed.
Rearrange the other segments to form a coherent statement.

He opened the old box / (P) finding several old letters / (Q) and looked inside
carefully / (R) which were neatly tied together / (S) with a faded ribbon

Ans A. Q P R S

B. P R Q S

C. P Q R S

D. Q R P S

Question Type : MCQ
Question ID : 4410091825745
Option 1 ID : 4410097197267
Option 2 ID : 4410097197268
Option 3 ID : 4410097197266
Option 4 ID : 4410097197269

Status : Not Answered
Chosen Option : --

Q.53 Select the most appropriate meaning of the given proverb.

A journey of a thousand miles begins with a single step.
463

Ans A. A big journey always takes time.

B. Nothing great is ever achieved without some effort.

C. Nothing can be achieved alone.

D. It is time to begin the journey soon.

Question Type : MCQ
Question ID : 441009823628
Option 1 ID : 4410093248599
Option 2 ID : 4410093248598
Option 3 ID : 4410093248601
Option 4 ID : 4410093248600

Status : Not Answered
Chosen Option : --

Q.54 Choose the correct option to substitute the underlined words in the sentence.

After collecting their savings to build a hospital, the children are now seeking people
ready to work without pay to provide medical care to the villagers.

Ans A. pioneers

B. employees

C. volunteers

D. staff

Question Type : MCQ
Question ID : 4410091830328
Option 1 ID : 4410097215302
Option 2 ID : 4410097215299
Option 3 ID : 4410097215300
Option 4 ID : 4410097215301

Status : Not Answered
Chosen Option : --
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Q.55 Choose the option that expresses the given statement in active voice.

The results will be announced by the principal tomorrow.

Ans A. Tomorrow will announce the principal the results.

B. The principal is going to announce the results tomorrow.

C. The principal is announcing the results tomorrow.

D. The principal will announce the results tomorrow.

Question Type : MCQ
Question ID : 4410091831941
Option 1 ID : 4410097221809
Option 2 ID : 4410097221810
Option 3 ID : 4410097221808
Option 4 ID : 4410097221807

Status : Answered
Chosen Option : B

Q.56 Identify the synonym of the underlined word in the sentence.

The student’s explanation was lucid and easy to understand.

Ans A. clear

B. obscure

C. perplexing

D. ambiguous

Question Type : MCQ
Question ID : 4410091831387
Option 1 ID : 4410097219435
Option 2 ID : 4410097219436
Option 3 ID : 4410097219438
Option 4 ID : 4410097219437

Status : Not Answered
Chosen Option : --

Q.57 Choose the option that uses the correct form of past tense.

While I ate dinner, my brother was calling me repeatedly.

Ans A. While I had eaten dinner, my brother has called me repeatedly.

B. While I eating dinner, my brother was calling me repeatedly.

C. While I eat dinner, my brother was calling me repeatedly.

D. While I was eating dinner, my brother was calling me repeatedly.

Question Type : MCQ
Question ID : 4410091825528
Option 1 ID : 4410097196417
Option 2 ID : 4410097196418
Option 3 ID : 4410097196415
Option 4 ID : 4410097196416

Status : Answered
Chosen Option : C
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Q.58 In the following sentence, substitute the highlighted segment with the most
appropriate option that preserves the idiomatic meaning of the sentence.
After his surgery, John managed to recover completely and return to his normal
life.

Ans A. pull up his socks

B. turn over a new leaf

C. stand up for himself

D. get back on his feet

Question Type : MCQ
Question ID : 4410091819329
Option 1 ID : 4410097172592
Option 2 ID : 4410097172593
Option 3 ID : 4410097172591
Option 4 ID : 4410097172590

Status : Not Answered
Chosen Option : --

Q.59 Choose the correct one-word substitute for the highlighted segment.

He is a/an person who excessively admires himself.

Ans A. narcissist

B. boaster

C. egoist

D. admirer

Question Type : MCQ
Question ID : 4410091825733
Option 1 ID : 4410097197218
Option 2 ID : 4410097197221
Option 3 ID : 4410097197219
Option 4 ID : 4410097197220

Status : Not Answered
Chosen Option : --

Q.60 Which part of the given sentence has an error?

(1) He submitted his assignment/ (2) lately and/ (3) was penalised by the teacher.

Ans A. (2) lately and

B. (4) No error

C. (1) He submitted his assignment

D. (3) was penalised by the teacher.

Question Type : MCQ
Question ID : 4410091819239
Option 1 ID : 4410097172231
Option 2 ID : 4410097172233
Option 3 ID : 4410097172230
Option 4 ID : 4410097172232

Status : Not Answered
Chosen Option : --
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Comprehension:

Read the passage and answer the questions.

Kuchipudi is a classical dance form that originated in the Indian state of Andhra Pradesh. It developed in a
village called Kuchipudi, where traditional performers presented dance dramas based on religious themes.
Historically, the dance was performed mainly by male artists, but today both men and women practice it
widely. Kuchipudi combines rhythmic footwork, expressive gestures, and graceful movements with dramatic
storytelling. Dancers use facial expressions and symbolic hand gestures to convey emotions and narrative
elements. The performance often includes dialogue, music, and elaborate costumes that enhance the
theatrical effect. One distinctive feature of Kuchipudi is the dance performed on the rim of a brass plate
while balancing a pot on the head, demonstrating remarkable control and coordination. Over time, the
dance has evolved from village performances to formal stage presentations in India and abroad. Today
Kuchipudi is recognized as an important part of India’s cultural heritage, appreciated for its artistic beauty
and expressive depth.

SubQuestion No : 61

Q.61 Select the option that best represents an appropriate title for the passage.

Ans A. The Theatre of Ancient Greek Drama

B. The Tradition of Kuchipudi Dance

C. The Festivals of Rural Folk Culture

D. The Music of South Indian Culture

Question Type : MCQ
Question ID : 4410091821741
Option 1 ID : 4410097182094
Option 2 ID : 4410097182092
Option 3 ID : 4410097182095
Option 4 ID : 4410097182093

Status : Not Answered
Chosen Option : --
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Comprehension:

Read the passage and answer the questions.

Kuchipudi is a classical dance form that originated in the Indian state of Andhra Pradesh. It developed in a
village called Kuchipudi, where traditional performers presented dance dramas based on religious themes.
Historically, the dance was performed mainly by male artists, but today both men and women practice it
widely. Kuchipudi combines rhythmic footwork, expressive gestures, and graceful movements with dramatic
storytelling. Dancers use facial expressions and symbolic hand gestures to convey emotions and narrative
elements. The performance often includes dialogue, music, and elaborate costumes that enhance the
theatrical effect. One distinctive feature of Kuchipudi is the dance performed on the rim of a brass plate
while balancing a pot on the head, demonstrating remarkable control and coordination. Over time, the
dance has evolved from village performances to formal stage presentations in India and abroad. Today
Kuchipudi is recognized as an important part of India’s cultural heritage, appreciated for its artistic beauty
and expressive depth.

SubQuestion No : 62

Q.62 Select the option that identifies a fact stated in the passage.

Ans A. Kuchipudi requires no music or dialogue.

B. Kuchipudi uses only simple costumes.

C. Kuchipudi was developed in North India.

D. Kuchipudi originated in Andhra Pradesh.

Question Type : MCQ
Question ID : 4410091821742
Option 1 ID : 4410097182098
Option 2 ID : 4410097182099
Option 3 ID : 4410097182096
Option 4 ID : 4410097182097

Status : Not Answered
Chosen Option : --
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Comprehension:

Read the passage and answer the questions.

Kuchipudi is a classical dance form that originated in the Indian state of Andhra Pradesh. It developed in a
village called Kuchipudi, where traditional performers presented dance dramas based on religious themes.
Historically, the dance was performed mainly by male artists, but today both men and women practice it
widely. Kuchipudi combines rhythmic footwork, expressive gestures, and graceful movements with dramatic
storytelling. Dancers use facial expressions and symbolic hand gestures to convey emotions and narrative
elements. The performance often includes dialogue, music, and elaborate costumes that enhance the
theatrical effect. One distinctive feature of Kuchipudi is the dance performed on the rim of a brass plate
while balancing a pot on the head, demonstrating remarkable control and coordination. Over time, the
dance has evolved from village performances to formal stage presentations in India and abroad. Today
Kuchipudi is recognized as an important part of India’s cultural heritage, appreciated for its artistic beauty
and expressive depth.

SubQuestion No : 63

Q.63 Select the option that identifies the tone of the passage.

Ans A. Critical and disapproving

B. Humorous and friendly

C. Informative and appreciative

D. Emotional and sentimental

Question Type : MCQ
Question ID : 4410091821743
Option 1 ID : 4410097182101
Option 2 ID : 4410097182103
Option 3 ID : 4410097182100
Option 4 ID : 4410097182102

Status : Not Answered
Chosen Option : --

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Comprehension:

Read the passage and answer the questions.

Kuchipudi is a classical dance form that originated in the Indian state of Andhra Pradesh. It developed in a
village called Kuchipudi, where traditional performers presented dance dramas based on religious themes.
Historically, the dance was performed mainly by male artists, but today both men and women practice it
widely. Kuchipudi combines rhythmic footwork, expressive gestures, and graceful movements with dramatic
storytelling. Dancers use facial expressions and symbolic hand gestures to convey emotions and narrative
elements. The performance often includes dialogue, music, and elaborate costumes that enhance the
theatrical effect. One distinctive feature of Kuchipudi is the dance performed on the rim of a brass plate
while balancing a pot on the head, demonstrating remarkable control and coordination. Over time, the
dance has evolved from village performances to formal stage presentations in India and abroad. Today
Kuchipudi is recognized as an important part of India’s cultural heritage, appreciated for its artistic beauty
and expressive depth.

SubQuestion No : 64

Q.64 Which situation best shows a real-life connection to the ideas described in the
passage?

Ans A. A musician practices complex rhythms to prepare for a formal cultural performance.

B. A student attends a classical dance workshop to learn expressive gestures and storytelling.

C. A theatre group studies ancient legends to prepare a historical stage performance.

D. A traveler visits several villages to study traditions connected with community life.

Question Type : MCQ
Question ID : 4410091821744
Option 1 ID : 4410097182105
Option 2 ID : 4410097182106
Option 3 ID : 4410097182107
Option 4 ID : 4410097182104

Status : Not Answered
Chosen Option : --
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Comprehension:

Read the passage and answer the questions.

Kuchipudi is a classical dance form that originated in the Indian state of Andhra Pradesh. It developed in a
village called Kuchipudi, where traditional performers presented dance dramas based on religious themes.
Historically, the dance was performed mainly by male artists, but today both men and women practice it
widely. Kuchipudi combines rhythmic footwork, expressive gestures, and graceful movements with dramatic
storytelling. Dancers use facial expressions and symbolic hand gestures to convey emotions and narrative
elements. The performance often includes dialogue, music, and elaborate costumes that enhance the
theatrical effect. One distinctive feature of Kuchipudi is the dance performed on the rim of a brass plate
while balancing a pot on the head, demonstrating remarkable control and coordination. Over time, the
dance has evolved from village performances to formal stage presentations in India and abroad. Today
Kuchipudi is recognized as an important part of India’s cultural heritage, appreciated for its artistic beauty
and expressive depth.

SubQuestion No : 65

Q.65 Select the sentence in which the word “remarkable” is used correctly as it is used in
the passage.

Ans A. The supervisor told the assistant to remarkable the pages that required correction in the file.

B. The editor decided to remarkable the paragraph to make the argument clearer for readers.

C. The athlete showed remarkable determination by finishing the marathon despite an injury.

D. The teacher asked the student to remarkable the important lines in the passage before discussion.

Question Type : MCQ
Question ID : 4410091821745
Option 1 ID : 4410097182108
Option 2 ID : 4410097182109
Option 3 ID : 4410097182111
Option 4 ID : 4410097182110

Status : Not Answered
Chosen Option : --

Q.66 ନିମ୍ନଲିଖିତ ପ୍ରଶ୍ନରେ ଦିଆଯାଇଥିବା ଚାରୋଟି ବିକଳ୍ପ ମଧ୍ୟରୁ  ସେହି ବିକଳ୍ପକୁ ବାଛନ୍ତୁ, ଯାହା ପ୍ରଦତ୍ତ ପ୍ରବାଦ ବା
ଲୋକବାଣୀର ଅର୍ଥକୁ
ସର୍ବୋତ୍ତମ ଭାବରେ ପ୍ରକାଶ କରେ।
ଘୋଡା ଛ‘ ଟଙ୍କାକୁ ଦାନା ନ’ ଟଙ୍କା

Ans A. କୌଣସି ଜିନିଷର ରକ୍ଷଣା ବେକ୍ଷଣ କରିବା

B. ଘୋଡ଼ାର ସ୍ୱାସ୍ଥ୍ୟ ଲାଗି ଦାନା କିଣିବା

C. ସାମାନ୍ୟ ଲାଭ ପାଇଁ  ଯଥେଷ୍ଟ ଖର୍ଚ୍ଚ କରିବା

D. ଅଧି କ ଲାଭ ପାଇଁ  ଘୋଡ଼ାକୁ ଅଧି କ ମୂଲ୍ୟର ଦାନା ଖୁଆଇବା

Question Type : MCQ
Question ID : 4410091238015
Option 1 ID : 4410094885590
Option 2 ID : 4410094885589
Option 3 ID : 4410094885588
Option 4 ID : 4410094885591

Status : Answered
Chosen Option : A

Section : Odia
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Q.67 ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।
ତୁମର ନିଜ କଠୋରୀ ଅଛି କି?

Ans A. Did you have your own room?

B. Do you have a room?

C. Do you have your own room?

D. Will you have your own room?

Question Type : MCQ
Question ID : 4410091230721
Option 1 ID : 4410094856378
Option 2 ID : 4410094856381
Option 3 ID : 4410094856379
Option 4 ID : 4410094856380

Status : Answered
Chosen Option : C

Q.68 ମୌସୁମୀର ପ୍ରଥମ ବର୍ଷାରେ ପିଲାମାନେ ______ ଖେଳୁଛନ୍ତି ।

Ans A. କାଲି

B. ପୂର୍ବରୁ

C. କ୍ୱଚିତ୍

D. ଖୁସିରେ

Question Type : MCQ
Question ID : 4410091675674
Option 1 ID : 4410096611524
Option 2 ID : 4410096611526
Option 3 ID : 4410096611527
Option 4 ID : 4410096611525

Status : Answered
Chosen Option : D

Q.69 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଅଣଓସାରିଆ

Ans A. ଲମ୍ବ

B. ଦୈର୍ଘ୍ୟ

C. ଗୋଲାକାର

D. ଓସାରିଆ

Question Type : MCQ
Question ID : 4410091676024
Option 1 ID : 4410096612918
Option 2 ID : 4410096612916
Option 3 ID : 4410096612919
Option 4 ID : 4410096612917

Status : Answered
Chosen Option : D
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Q.70 ______ ସେ କଠିନ ପରିଶ୍ରମ କରିଥିଲେ, ସେ ପରୀକ୍ଷାରେ ଫେଲ ହୋଇଥିଲେ।

Ans A. କାରଣ

B. ଯଦିଓ

C. ତେଣୁ

D. ଯେହେତୁ

Question Type : MCQ
Question ID : 4410091675415
Option 1 ID : 4410096610800
Option 2 ID : 4410096610801
Option 3 ID : 4410096610803
Option 4 ID : 4410096610802

Status : Answered
Chosen Option : D

Q.71 “କାଷ୍ଠ” ର ତଦ୍ଭବ ଶବ୍ଦ କ’ଣ?

Ans A. ଖଟ

B. କାଠ

C. କବାଟ

D. ଆଲମାରି

Question Type : MCQ
Question ID : 4410091235883
Option 1 ID : 4410094877114
Option 2 ID : 4410094877116
Option 3 ID : 4410094877115
Option 4 ID : 4410094877117

Status : Answered
Chosen Option : C

Q.72 ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

Somebody has put out the light.

Ans A. କେହି ଜଣେ ଲାଇଟ ଲିଭାଇ ଦେଇଛନ୍ତି।

B. କେହି ଜଣେ ଲାଇଟ ଲିଭାଇ ଦେଉଥି ଲେ।

C. କେହି ଜଣେ ଲାଇଟ ଲିଭାଇ ଦିଅନ୍ତି।

D. କେହି ଜଣେ ଲାଇଟ ଲିଭାଇବେ।

Question Type : MCQ
Question ID : 4410091233458
Option 1 ID : 4410094867506
Option 2 ID : 4410094867509
Option 3 ID : 4410094867507
Option 4 ID : 4410094867508

Status : Answered
Chosen Option : A
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Q.73 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଚନ୍ଦ୍ର

Ans A. ସୂର୍ଯ୍ୟ

B. ଆକାଶ

C. ମେଘ

D. ଶଶାଙ୍କ

Question Type : MCQ
Question ID : 4410091199604
Option 1 ID : 4410094732233
Option 2 ID : 4410094732235
Option 3 ID : 4410094732234
Option 4 ID : 4410094732232

Status : Answered
Chosen Option : D

Q.74 ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

I have very gladly accepted your proposal.

Ans A. ମୁଁ  ତୁ ମ ପ୍ରସ୍ତାବ ଗ୍ରହଣ କରି ଖୁସି ହୋଇଛି।

B. ମୁଁ  ବହୁତ ଖୁସିରେ ତୁ ମ ପ୍ରସ୍ତାବ ଗ୍ରହଣ କରିବି।

C. ମୁଁ  ବହୁତ ଖୁସିରେ ତୁ ମ ପ୍ରସ୍ତାବ ଗ୍ରହଣ କରିଛି।

D. ମୁଁ  ବହୁତ ଖୁସିରେ ତୁ ମ ପ୍ରସ୍ତାବ ଗ୍ରହଣ କରିଥି ଲି।

Question Type : MCQ
Question ID : 4410091233251
Option 1 ID : 4410094866705
Option 2 ID : 4410094866702
Option 3 ID : 4410094866704
Option 4 ID : 4410094866703

Status : Answered
Chosen Option : A

Q.75 ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରି ବାକ୍ୟଟିକୁ ସମ୍ପୂର୍ଣ୍ଣ କର ।

ତୁ ମେ ____ ଭଲ ଭାବରେ ପଢିବ , ତେବେ ନିଶ୍ଚୟ ପ୍ରଥମ ଶ୍ରେଣୀରେ ପାସ ପାଇବ ।

Ans A. ସୁତାର

B. ଯଥା

C. ପ୍ରାୟ

D. ଯେବେ

Question Type : MCQ
Question ID : 4410091483907
Option 1 ID : 4410095862504
Option 2 ID : 4410095862502
Option 3 ID : 4410095862503
Option 4 ID : 4410095862501

Status : Answered
Chosen Option : D
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ଛାତ୍ରମାନଙ୍କୁ ବିଶୃଙ୍ଖଳିତ ଆଚରଣ କରିବାକୁ ସମାଜ ନିଜେ ବାଧ୍ୟ କରୁ ଛି। ସମାଜରୁ  ସେମାନେ ଯେଉଁ  ନୈତିକ ଦିଗ୍‌ଦର୍ଶନ ଓ ଆଦର୍ଶ ଆଶା
କରିବାର କଥା, ତାହା କୌଣସି ମାତ୍ରାରେ ପାଇପାରୁ  ନାହାନ୍ତି। ନୈତିକ ମୂଲ୍ୟବୋଧ ଦ୍ୱାରା ପରିଚାଳିତ ବ୍ୟକ୍ତିଙ୍କ ସଂଖ୍ୟା ନିହାତି କମ୍‌
ହୋଇଯାଇଛି। ନିଶା, ଅନାଚାର, ନଗ୍ନତା ଓ ଅଶ୍ଳୀଳ ଆଚରଣ ଛାତ୍ରସମାଜକୁ ବିଷାକ୍ତ କରି ତୋଳୁଛି। ଚଳଚ୍ଚିତ୍ରର ନଗ୍ନ ଦୃଶ୍ୟ, ଅଶ୍ଳୀଳ ସଙ୍ଗୀତ ଓ
ଉଦ୍ଦୀପକ ପୋଷାକ କାନ୍ଥ ଓ ପ୍ରାଚୀରରେ ପ୍ରଚାରିତ ହେଉଛି। ଲୋଭନୀୟ ଜୀବନଶୈଳୀ ଓ ଅନୈତିକ ସମ୍ପର୍କ ଛାତ୍ରମାନଙ୍କୁ ବିପଥଗାମୀ କରୁ ଛି।
ଏହାର କୁପ୍ରଭାବ ସମାଜର ସବୁ କ୍ଷେତ୍ରରେ ଅନୁଭୂ ତ ହେଉଛି, କିନ୍ତୁ ପ୍ରତିକାର ପାଇଁ  କୌଣସି ଗମ୍ଭୀର ଉଦ୍ୟମ ଦେଖାଯାଉ ନାହିଁ। ଏହି
ସାମାଜିକ ଓ ସାଂସ୍କୃ ତିକ ପରିବେଶରୁ  ଛାତ୍ରମାନେ ବିଶୃଙ୍ଖଳା ବ୍ୟତୀତ ଅନ୍ୟ କ’ଣ ଶିଖି ବେ? ସମ୍ବାଦପତ୍ରର ପୃଷ୍ଠା  ଓଲଟାଇଲେ ପ୍ରତିଦିନ ଧର୍ଷଣ,
ହିଂସା ଓ ଅପରାଧ ଖବର ଦେଖାଯାଉଛି। ଚଳଚ୍ଚିତ୍ରର କାମୋଦ୍ଦୀପକ ନୃତ୍ୟ, ଅଭିନୟ ଓ ଅଭିନେତ୍ରୀଙ୍କ ଅଶ୍ଳୀଳ ଭୂ ମିକା ଛାତ୍ର ବିଶୃଙ୍ଖଳାର ମୂଳ
କାରଣ। ଶିକ୍ଷାନୁଷ୍ଠା ନମାନଙ୍କରେ ରାଜନୈତିକ ହସ୍ତକ୍ଷେପ ବହୁପରିମାଣରେ ବିଶୃଙ୍ଖଳାକୁ ଉସ୍କାଇ ଦେଉଛି। ଅନୈତିକ ରାଜନୀତିର
ବିଚରଣଭୂ ମିରେ ପରିଣତ ହୋଇଛି ଶିକ୍ଷାଙ୍ଗନ। ସ୍ୱାର୍ଥପର ରାଜନୀତିଜ୍ଞମାନେ କ୍ଷମତା ଲାଳସାରେ କୋମଳମତି ଛାତ୍ରମାନଙ୍କୁ ବଳି ପକାଇ
ଶିକ୍ଷାନୁଷ୍ଠା ନର ପବିତ୍ର ବାତାବରଣ ନଷ୍ଟ କରୁ ଛନ୍ତି। ଧର୍ମଘଟ, ଆଇନ ଅମାନ୍ୟ, ଜାତୀୟ ସମ୍ପଦ ନଷ୍ଟ ଓ ହିଂସାତ୍ମକ କାର୍ଯ୍ୟରେ ଲିପ୍ତ ହୋଇ
ଛାତ୍ରମାନେ ନିଜ ଭବିଷ୍ୟତ ଧ୍ୱଂସ କରୁ ଛନ୍ତି। ଛାତ୍ରସଂସଦ ନିର୍ବାଚନରେ ରାଜନୈତିକ ଦଳଗୁଡ଼ିକ ପ୍ରତ୍ୟକ୍ଷ ହସ୍ତକ୍ଷେପ କରି ଶିକ୍ଷାଙ୍ଗନର ମର୍ଯ୍ୟାଦା
ହାନି କରୁ ଛନ୍ତି। ଅବୋଧ ଯୁବକମାନେ ମଧୁର ପ୍ରତିଶ୍ରୁ ତିରେ ଭୁ ଲି ନିଜର ସୁନ୍ଦର ଭବିଷ୍ୟତ ନଷ୍ଟ କରୁ ଛନ୍ତି। ପ୍ରଚଳିତ ତ୍ରୁଟିପୂର୍ଣ୍ଣ ଶିକ୍ଷାପଦ୍ଧତି ମଧ୍ୟ
ବିଶୃଙ୍ଖଳାର କାରଣ। ଏହା ଛାତ୍ରମାନଙ୍କୁ ଅନିଶ୍ଚିତ ଭବିଷ୍ୟତ ଦେଖାଉଛି। ଶିକ୍ଷାଲାଭ ପରେ ନିଯୁକ୍ତିର କୌଣସି ନିଶ୍ଚୟତା ନାହିଁ।

SubQuestion No : 76

Q.76 ଅନୁଚ୍ଛେଦ ପାଇଁ  ଯୋଗ୍ୟ ସାରାଂଶ ଚୟନ କର।

Ans A. ଛାତ୍ରମାନେ କେବଳ ମନୋରଞ୍ଜନକୁ ପସନ୍ଦ କରନ୍ତି।

B. ସମାଜ, ଚଳଚ୍ଚିତ୍ର, ରାଜନୀତି ଓ ଶିକ୍ଷା ପଦ୍ଧତି ଛାତ୍ରମାନଙ୍କ ଆଚରଣକୁ ବିଶୃଙ୍ଖଳ କରୁ ଛି।

C. ଛାତ୍ରମାନେ ଏବେ ବହୁତ ମେହନତି ଓ ନୈତିକ।

D. ଛାତ୍ରମାନଙ୍କ ପାଖରେ ପଢ଼ିବାର ସମୟ ନାହିଁ।

Question Type : MCQ
Question ID : 4410091481877
Option 1 ID : 4410095854555
Option 2 ID : 4410095854554
Option 3 ID : 4410095854553
Option 4 ID : 4410095854556

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ଛାତ୍ରମାନଙ୍କୁ ବିଶୃଙ୍ଖଳିତ ଆଚରଣ କରିବାକୁ ସମାଜ ନିଜେ ବାଧ୍ୟ କରୁ ଛି। ସମାଜରୁ  ସେମାନେ ଯେଉଁ  ନୈତିକ ଦିଗ୍‌ଦର୍ଶନ ଓ ଆଦର୍ଶ ଆଶା
କରିବାର କଥା, ତାହା କୌଣସି ମାତ୍ରାରେ ପାଇପାରୁ  ନାହାନ୍ତି। ନୈତିକ ମୂଲ୍ୟବୋଧ ଦ୍ୱାରା ପରିଚାଳିତ ବ୍ୟକ୍ତିଙ୍କ ସଂଖ୍ୟା ନିହାତି କମ୍‌
ହୋଇଯାଇଛି। ନିଶା, ଅନାଚାର, ନଗ୍ନତା ଓ ଅଶ୍ଳୀଳ ଆଚରଣ ଛାତ୍ରସମାଜକୁ ବିଷାକ୍ତ କରି ତୋଳୁଛି। ଚଳଚ୍ଚିତ୍ରର ନଗ୍ନ ଦୃଶ୍ୟ, ଅଶ୍ଳୀଳ ସଙ୍ଗୀତ ଓ
ଉଦ୍ଦୀପକ ପୋଷାକ କାନ୍ଥ ଓ ପ୍ରାଚୀରରେ ପ୍ରଚାରିତ ହେଉଛି। ଲୋଭନୀୟ ଜୀବନଶୈଳୀ ଓ ଅନୈତିକ ସମ୍ପର୍କ ଛାତ୍ରମାନଙ୍କୁ ବିପଥଗାମୀ କରୁ ଛି।
ଏହାର କୁପ୍ରଭାବ ସମାଜର ସବୁ କ୍ଷେତ୍ରରେ ଅନୁଭୂ ତ ହେଉଛି, କିନ୍ତୁ ପ୍ରତିକାର ପାଇଁ  କୌଣସି ଗମ୍ଭୀର ଉଦ୍ୟମ ଦେଖାଯାଉ ନାହିଁ। ଏହି
ସାମାଜିକ ଓ ସାଂସ୍କୃ ତିକ ପରିବେଶରୁ  ଛାତ୍ରମାନେ ବିଶୃଙ୍ଖଳା ବ୍ୟତୀତ ଅନ୍ୟ କ’ଣ ଶିଖି ବେ? ସମ୍ବାଦପତ୍ରର ପୃଷ୍ଠା  ଓଲଟାଇଲେ ପ୍ରତିଦିନ ଧର୍ଷଣ,
ହିଂସା ଓ ଅପରାଧ ଖବର ଦେଖାଯାଉଛି। ଚଳଚ୍ଚିତ୍ରର କାମୋଦ୍ଦୀପକ ନୃତ୍ୟ, ଅଭିନୟ ଓ ଅଭିନେତ୍ରୀଙ୍କ ଅଶ୍ଳୀଳ ଭୂ ମିକା ଛାତ୍ର ବିଶୃଙ୍ଖଳାର ମୂଳ
କାରଣ। ଶିକ୍ଷାନୁଷ୍ଠା ନମାନଙ୍କରେ ରାଜନୈତିକ ହସ୍ତକ୍ଷେପ ବହୁପରିମାଣରେ ବିଶୃଙ୍ଖଳାକୁ ଉସ୍କାଇ ଦେଉଛି। ଅନୈତିକ ରାଜନୀତିର
ବିଚରଣଭୂ ମିରେ ପରିଣତ ହୋଇଛି ଶିକ୍ଷାଙ୍ଗନ। ସ୍ୱାର୍ଥପର ରାଜନୀତିଜ୍ଞମାନେ କ୍ଷମତା ଲାଳସାରେ କୋମଳମତି ଛାତ୍ରମାନଙ୍କୁ ବଳି ପକାଇ
ଶିକ୍ଷାନୁଷ୍ଠା ନର ପବିତ୍ର ବାତାବରଣ ନଷ୍ଟ କରୁ ଛନ୍ତି। ଧର୍ମଘଟ, ଆଇନ ଅମାନ୍ୟ, ଜାତୀୟ ସମ୍ପଦ ନଷ୍ଟ ଓ ହିଂସାତ୍ମକ କାର୍ଯ୍ୟରେ ଲିପ୍ତ ହୋଇ
ଛାତ୍ରମାନେ ନିଜ ଭବିଷ୍ୟତ ଧ୍ୱଂସ କରୁ ଛନ୍ତି। ଛାତ୍ରସଂସଦ ନିର୍ବାଚନରେ ରାଜନୈତିକ ଦଳଗୁଡ଼ିକ ପ୍ରତ୍ୟକ୍ଷ ହସ୍ତକ୍ଷେପ କରି ଶିକ୍ଷାଙ୍ଗନର ମର୍ଯ୍ୟାଦା
ହାନି କରୁ ଛନ୍ତି। ଅବୋଧ ଯୁବକମାନେ ମଧୁର ପ୍ରତିଶ୍ରୁ ତିରେ ଭୁ ଲି ନିଜର ସୁନ୍ଦର ଭବିଷ୍ୟତ ନଷ୍ଟ କରୁ ଛନ୍ତି। ପ୍ରଚଳିତ ତ୍ରୁଟିପୂର୍ଣ୍ଣ ଶିକ୍ଷାପଦ୍ଧତି ମଧ୍ୟ
ବିଶୃଙ୍ଖଳାର କାରଣ। ଏହା ଛାତ୍ରମାନଙ୍କୁ ଅନିଶ୍ଚିତ ଭବିଷ୍ୟତ ଦେଖାଉଛି। ଶିକ୍ଷାଲାଭ ପରେ ନିଯୁକ୍ତିର କୌଣସି ନିଶ୍ଚୟତା ନାହିଁ।

SubQuestion No : 77

Q.77 ଅନୁଚ୍ଛେଦର ମୁଖ୍ୟ ବିଷୟବସ୍ତୁ  କ’ଣ?

Ans A. ଶିକ୍ଷାଙ୍ଗନର ସୌନ୍ଦର୍ଯ୍ୟ

B. ଛାତ୍ରମାନଙ୍କ ଖେଳାଧୁଳା ଜୀବନ

C. ଛାତ୍ରମାନଙ୍କ ଭମଣ ଓ ବିନୋଦନ

D. ଛାତ୍ର ବିଶୃଙ୍ଖଳାର କାରଣ ଓ ତାହାର ପ୍ରଭାବ

Question Type : MCQ
Question ID : 4410091481878
Option 1 ID : 4410095854558
Option 2 ID : 4410095854557
Option 3 ID : 4410095854560
Option 4 ID : 4410095854559

Status : Answered
Chosen Option : D
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ଛାତ୍ରମାନଙ୍କୁ ବିଶୃଙ୍ଖଳିତ ଆଚରଣ କରିବାକୁ ସମାଜ ନିଜେ ବାଧ୍ୟ କରୁ ଛି। ସମାଜରୁ  ସେମାନେ ଯେଉଁ  ନୈତିକ ଦିଗ୍‌ଦର୍ଶନ ଓ ଆଦର୍ଶ ଆଶା
କରିବାର କଥା, ତାହା କୌଣସି ମାତ୍ରାରେ ପାଇପାରୁ  ନାହାନ୍ତି। ନୈତିକ ମୂଲ୍ୟବୋଧ ଦ୍ୱାରା ପରିଚାଳିତ ବ୍ୟକ୍ତିଙ୍କ ସଂଖ୍ୟା ନିହାତି କମ୍‌
ହୋଇଯାଇଛି। ନିଶା, ଅନାଚାର, ନଗ୍ନତା ଓ ଅଶ୍ଳୀଳ ଆଚରଣ ଛାତ୍ରସମାଜକୁ ବିଷାକ୍ତ କରି ତୋଳୁଛି। ଚଳଚ୍ଚିତ୍ରର ନଗ୍ନ ଦୃଶ୍ୟ, ଅଶ୍ଳୀଳ ସଙ୍ଗୀତ ଓ
ଉଦ୍ଦୀପକ ପୋଷାକ କାନ୍ଥ ଓ ପ୍ରାଚୀରରେ ପ୍ରଚାରିତ ହେଉଛି। ଲୋଭନୀୟ ଜୀବନଶୈଳୀ ଓ ଅନୈତିକ ସମ୍ପର୍କ ଛାତ୍ରମାନଙ୍କୁ ବିପଥଗାମୀ କରୁ ଛି।
ଏହାର କୁପ୍ରଭାବ ସମାଜର ସବୁ କ୍ଷେତ୍ରରେ ଅନୁଭୂ ତ ହେଉଛି, କିନ୍ତୁ ପ୍ରତିକାର ପାଇଁ  କୌଣସି ଗମ୍ଭୀର ଉଦ୍ୟମ ଦେଖାଯାଉ ନାହିଁ। ଏହି
ସାମାଜିକ ଓ ସାଂସ୍କୃ ତିକ ପରିବେଶରୁ  ଛାତ୍ରମାନେ ବିଶୃଙ୍ଖଳା ବ୍ୟତୀତ ଅନ୍ୟ କ’ଣ ଶିଖି ବେ? ସମ୍ବାଦପତ୍ରର ପୃଷ୍ଠା  ଓଲଟାଇଲେ ପ୍ରତିଦିନ ଧର୍ଷଣ,
ହିଂସା ଓ ଅପରାଧ ଖବର ଦେଖାଯାଉଛି। ଚଳଚ୍ଚିତ୍ରର କାମୋଦ୍ଦୀପକ ନୃତ୍ୟ, ଅଭିନୟ ଓ ଅଭିନେତ୍ରୀଙ୍କ ଅଶ୍ଳୀଳ ଭୂ ମିକା ଛାତ୍ର ବିଶୃଙ୍ଖଳାର ମୂଳ
କାରଣ। ଶିକ୍ଷାନୁଷ୍ଠା ନମାନଙ୍କରେ ରାଜନୈତିକ ହସ୍ତକ୍ଷେପ ବହୁପରିମାଣରେ ବିଶୃଙ୍ଖଳାକୁ ଉସ୍କାଇ ଦେଉଛି। ଅନୈତିକ ରାଜନୀତିର
ବିଚରଣଭୂ ମିରେ ପରିଣତ ହୋଇଛି ଶିକ୍ଷାଙ୍ଗନ। ସ୍ୱାର୍ଥପର ରାଜନୀତିଜ୍ଞମାନେ କ୍ଷମତା ଲାଳସାରେ କୋମଳମତି ଛାତ୍ରମାନଙ୍କୁ ବଳି ପକାଇ
ଶିକ୍ଷାନୁଷ୍ଠା ନର ପବିତ୍ର ବାତାବରଣ ନଷ୍ଟ କରୁ ଛନ୍ତି। ଧର୍ମଘଟ, ଆଇନ ଅମାନ୍ୟ, ଜାତୀୟ ସମ୍ପଦ ନଷ୍ଟ ଓ ହିଂସାତ୍ମକ କାର୍ଯ୍ୟରେ ଲିପ୍ତ ହୋଇ
ଛାତ୍ରମାନେ ନିଜ ଭବିଷ୍ୟତ ଧ୍ୱଂସ କରୁ ଛନ୍ତି। ଛାତ୍ରସଂସଦ ନିର୍ବାଚନରେ ରାଜନୈତିକ ଦଳଗୁଡ଼ିକ ପ୍ରତ୍ୟକ୍ଷ ହସ୍ତକ୍ଷେପ କରି ଶିକ୍ଷାଙ୍ଗନର ମର୍ଯ୍ୟାଦା
ହାନି କରୁ ଛନ୍ତି। ଅବୋଧ ଯୁବକମାନେ ମଧୁର ପ୍ରତିଶ୍ରୁ ତିରେ ଭୁ ଲି ନିଜର ସୁନ୍ଦର ଭବିଷ୍ୟତ ନଷ୍ଟ କରୁ ଛନ୍ତି। ପ୍ରଚଳିତ ତ୍ରୁଟିପୂର୍ଣ୍ଣ ଶିକ୍ଷାପଦ୍ଧତି ମଧ୍ୟ
ବିଶୃଙ୍ଖଳାର କାରଣ। ଏହା ଛାତ୍ରମାନଙ୍କୁ ଅନିଶ୍ଚିତ ଭବିଷ୍ୟତ ଦେଖାଉଛି। ଶିକ୍ଷାଲାଭ ପରେ ନିଯୁକ୍ତିର କୌଣସି ନିଶ୍ଚୟତା ନାହିଁ।

SubQuestion No : 78

Q.78 ଉପଯୁକ୍ତ ଶୀର୍ଷକ ଚିହ୍ନଟ କର।

Ans A. ବିପଥଗାମୀ ଛାତ୍ର ସମାଜ

B. ରାଜନୀତିର ଉନ୍ନତି

C. ଛାତ୍ର ଓ ପରୀକ୍ଷା

D. ମନୋରଞ୍ଜନ ଓ ଚଳଚ୍ଚିତ୍ର

Question Type : MCQ
Question ID : 4410091481879
Option 1 ID : 4410095854562
Option 2 ID : 4410095854564
Option 3 ID : 4410095854561
Option 4 ID : 4410095854563

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ଛାତ୍ରମାନଙ୍କୁ ବିଶୃଙ୍ଖଳିତ ଆଚରଣ କରିବାକୁ ସମାଜ ନିଜେ ବାଧ୍ୟ କରୁ ଛି। ସମାଜରୁ  ସେମାନେ ଯେଉଁ  ନୈତିକ ଦିଗ୍‌ଦର୍ଶନ ଓ ଆଦର୍ଶ ଆଶା
କରିବାର କଥା, ତାହା କୌଣସି ମାତ୍ରାରେ ପାଇପାରୁ  ନାହାନ୍ତି। ନୈତିକ ମୂଲ୍ୟବୋଧ ଦ୍ୱାରା ପରିଚାଳିତ ବ୍ୟକ୍ତିଙ୍କ ସଂଖ୍ୟା ନିହାତି କମ୍‌
ହୋଇଯାଇଛି। ନିଶା, ଅନାଚାର, ନଗ୍ନତା ଓ ଅଶ୍ଳୀଳ ଆଚରଣ ଛାତ୍ରସମାଜକୁ ବିଷାକ୍ତ କରି ତୋଳୁଛି। ଚଳଚ୍ଚିତ୍ରର ନଗ୍ନ ଦୃଶ୍ୟ, ଅଶ୍ଳୀଳ ସଙ୍ଗୀତ ଓ
ଉଦ୍ଦୀପକ ପୋଷାକ କାନ୍ଥ ଓ ପ୍ରାଚୀରରେ ପ୍ରଚାରିତ ହେଉଛି। ଲୋଭନୀୟ ଜୀବନଶୈଳୀ ଓ ଅନୈତିକ ସମ୍ପର୍କ ଛାତ୍ରମାନଙ୍କୁ ବିପଥଗାମୀ କରୁ ଛି।
ଏହାର କୁପ୍ରଭାବ ସମାଜର ସବୁ କ୍ଷେତ୍ରରେ ଅନୁଭୂ ତ ହେଉଛି, କିନ୍ତୁ ପ୍ରତିକାର ପାଇଁ  କୌଣସି ଗମ୍ଭୀର ଉଦ୍ୟମ ଦେଖାଯାଉ ନାହିଁ। ଏହି
ସାମାଜିକ ଓ ସାଂସ୍କୃ ତିକ ପରିବେଶରୁ  ଛାତ୍ରମାନେ ବିଶୃଙ୍ଖଳା ବ୍ୟତୀତ ଅନ୍ୟ କ’ଣ ଶିଖି ବେ? ସମ୍ବାଦପତ୍ରର ପୃଷ୍ଠା  ଓଲଟାଇଲେ ପ୍ରତିଦିନ ଧର୍ଷଣ,
ହିଂସା ଓ ଅପରାଧ ଖବର ଦେଖାଯାଉଛି। ଚଳଚ୍ଚିତ୍ରର କାମୋଦ୍ଦୀପକ ନୃତ୍ୟ, ଅଭିନୟ ଓ ଅଭିନେତ୍ରୀଙ୍କ ଅଶ୍ଳୀଳ ଭୂ ମିକା ଛାତ୍ର ବିଶୃଙ୍ଖଳାର ମୂଳ
କାରଣ। ଶିକ୍ଷାନୁଷ୍ଠା ନମାନଙ୍କରେ ରାଜନୈତିକ ହସ୍ତକ୍ଷେପ ବହୁପରିମାଣରେ ବିଶୃଙ୍ଖଳାକୁ ଉସ୍କାଇ ଦେଉଛି। ଅନୈତିକ ରାଜନୀତିର
ବିଚରଣଭୂ ମିରେ ପରିଣତ ହୋଇଛି ଶିକ୍ଷାଙ୍ଗନ। ସ୍ୱାର୍ଥପର ରାଜନୀତିଜ୍ଞମାନେ କ୍ଷମତା ଲାଳସାରେ କୋମଳମତି ଛାତ୍ରମାନଙ୍କୁ ବଳି ପକାଇ
ଶିକ୍ଷାନୁଷ୍ଠା ନର ପବିତ୍ର ବାତାବରଣ ନଷ୍ଟ କରୁ ଛନ୍ତି। ଧର୍ମଘଟ, ଆଇନ ଅମାନ୍ୟ, ଜାତୀୟ ସମ୍ପଦ ନଷ୍ଟ ଓ ହିଂସାତ୍ମକ କାର୍ଯ୍ୟରେ ଲିପ୍ତ ହୋଇ
ଛାତ୍ରମାନେ ନିଜ ଭବିଷ୍ୟତ ଧ୍ୱଂସ କରୁ ଛନ୍ତି। ଛାତ୍ରସଂସଦ ନିର୍ବାଚନରେ ରାଜନୈତିକ ଦଳଗୁଡ଼ିକ ପ୍ରତ୍ୟକ୍ଷ ହସ୍ତକ୍ଷେପ କରି ଶିକ୍ଷାଙ୍ଗନର ମର୍ଯ୍ୟାଦା
ହାନି କରୁ ଛନ୍ତି। ଅବୋଧ ଯୁବକମାନେ ମଧୁର ପ୍ରତିଶ୍ରୁ ତିରେ ଭୁ ଲି ନିଜର ସୁନ୍ଦର ଭବିଷ୍ୟତ ନଷ୍ଟ କରୁ ଛନ୍ତି। ପ୍ରଚଳିତ ତ୍ରୁଟିପୂର୍ଣ୍ଣ ଶିକ୍ଷାପଦ୍ଧତି ମଧ୍ୟ
ବିଶୃଙ୍ଖଳାର କାରଣ। ଏହା ଛାତ୍ରମାନଙ୍କୁ ଅନିଶ୍ଚିତ ଭବିଷ୍ୟତ ଦେଖାଉଛି। ଶିକ୍ଷାଲାଭ ପରେ ନିଯୁକ୍ତିର କୌଣସି ନିଶ୍ଚୟତା ନାହିଁ।

SubQuestion No : 79

Q.79 “ବିଶୃଙ୍ଖଳା” ଶବ୍ଦର ସଠିକ ବ୍ୟବହାର ବାଛନ୍ତୁ।

Ans A. ପକ୍ଷୀମାନେ ବିଶୃଙ୍ଖଳା ଖାଇଁ ।

B. ଚାମ୍ପା ଫୁଲ ବହୁତ ବିଶୃଙ୍ଖଳା ହୁଏ।

C. ବାଣ ଫୁଟିଲେ ବିଶୃଙ୍ଖଳା ଦେଖାଯାଏ।

D. ପରିବେଶ ବିଶୃଙ୍ଖଳା ହେଲେ ମଣିଷ ସୁସ୍ଥ ରହିପାରିବ ନାହିଁ।

Question Type : MCQ
Question ID : 4410091481880
Option 1 ID : 4410095854568
Option 2 ID : 4410095854567
Option 3 ID : 4410095854566
Option 4 ID : 4410095854565

Status : Answered
Chosen Option : D
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ଛାତ୍ରମାନଙ୍କୁ ବିଶୃଙ୍ଖଳିତ ଆଚରଣ କରିବାକୁ ସମାଜ ନିଜେ ବାଧ୍ୟ କରୁ ଛି। ସମାଜରୁ  ସେମାନେ ଯେଉଁ  ନୈତିକ ଦିଗ୍‌ଦର୍ଶନ ଓ ଆଦର୍ଶ ଆଶା
କରିବାର କଥା, ତାହା କୌଣସି ମାତ୍ରାରେ ପାଇପାରୁ  ନାହାନ୍ତି। ନୈତିକ ମୂଲ୍ୟବୋଧ ଦ୍ୱାରା ପରିଚାଳିତ ବ୍ୟକ୍ତିଙ୍କ ସଂଖ୍ୟା ନିହାତି କମ୍‌
ହୋଇଯାଇଛି। ନିଶା, ଅନାଚାର, ନଗ୍ନତା ଓ ଅଶ୍ଳୀଳ ଆଚରଣ ଛାତ୍ରସମାଜକୁ ବିଷାକ୍ତ କରି ତୋଳୁଛି। ଚଳଚ୍ଚିତ୍ରର ନଗ୍ନ ଦୃଶ୍ୟ, ଅଶ୍ଳୀଳ ସଙ୍ଗୀତ ଓ
ଉଦ୍ଦୀପକ ପୋଷାକ କାନ୍ଥ ଓ ପ୍ରାଚୀରରେ ପ୍ରଚାରିତ ହେଉଛି। ଲୋଭନୀୟ ଜୀବନଶୈଳୀ ଓ ଅନୈତିକ ସମ୍ପର୍କ ଛାତ୍ରମାନଙ୍କୁ ବିପଥଗାମୀ କରୁ ଛି।
ଏହାର କୁପ୍ରଭାବ ସମାଜର ସବୁ କ୍ଷେତ୍ରରେ ଅନୁଭୂ ତ ହେଉଛି, କିନ୍ତୁ ପ୍ରତିକାର ପାଇଁ  କୌଣସି ଗମ୍ଭୀର ଉଦ୍ୟମ ଦେଖାଯାଉ ନାହିଁ। ଏହି
ସାମାଜିକ ଓ ସାଂସ୍କୃ ତିକ ପରିବେଶରୁ  ଛାତ୍ରମାନେ ବିଶୃଙ୍ଖଳା ବ୍ୟତୀତ ଅନ୍ୟ କ’ଣ ଶିଖି ବେ? ସମ୍ବାଦପତ୍ରର ପୃଷ୍ଠା  ଓଲଟାଇଲେ ପ୍ରତିଦିନ ଧର୍ଷଣ,
ହିଂସା ଓ ଅପରାଧ ଖବର ଦେଖାଯାଉଛି। ଚଳଚ୍ଚିତ୍ରର କାମୋଦ୍ଦୀପକ ନୃତ୍ୟ, ଅଭିନୟ ଓ ଅଭିନେତ୍ରୀଙ୍କ ଅଶ୍ଳୀଳ ଭୂ ମିକା ଛାତ୍ର ବିଶୃଙ୍ଖଳାର ମୂଳ
କାରଣ। ଶିକ୍ଷାନୁଷ୍ଠା ନମାନଙ୍କରେ ରାଜନୈତିକ ହସ୍ତକ୍ଷେପ ବହୁପରିମାଣରେ ବିଶୃଙ୍ଖଳାକୁ ଉସ୍କାଇ ଦେଉଛି। ଅନୈତିକ ରାଜନୀତିର
ବିଚରଣଭୂ ମିରେ ପରିଣତ ହୋଇଛି ଶିକ୍ଷାଙ୍ଗନ। ସ୍ୱାର୍ଥପର ରାଜନୀତିଜ୍ଞମାନେ କ୍ଷମତା ଲାଳସାରେ କୋମଳମତି ଛାତ୍ରମାନଙ୍କୁ ବଳି ପକାଇ
ଶିକ୍ଷାନୁଷ୍ଠା ନର ପବିତ୍ର ବାତାବରଣ ନଷ୍ଟ କରୁ ଛନ୍ତି। ଧର୍ମଘଟ, ଆଇନ ଅମାନ୍ୟ, ଜାତୀୟ ସମ୍ପଦ ନଷ୍ଟ ଓ ହିଂସାତ୍ମକ କାର୍ଯ୍ୟରେ ଲିପ୍ତ ହୋଇ
ଛାତ୍ରମାନେ ନିଜ ଭବିଷ୍ୟତ ଧ୍ୱଂସ କରୁ ଛନ୍ତି। ଛାତ୍ରସଂସଦ ନିର୍ବାଚନରେ ରାଜନୈତିକ ଦଳଗୁଡ଼ିକ ପ୍ରତ୍ୟକ୍ଷ ହସ୍ତକ୍ଷେପ କରି ଶିକ୍ଷାଙ୍ଗନର ମର୍ଯ୍ୟାଦା
ହାନି କରୁ ଛନ୍ତି। ଅବୋଧ ଯୁବକମାନେ ମଧୁର ପ୍ରତିଶ୍ରୁ ତିରେ ଭୁ ଲି ନିଜର ସୁନ୍ଦର ଭବିଷ୍ୟତ ନଷ୍ଟ କରୁ ଛନ୍ତି। ପ୍ରଚଳିତ ତ୍ରୁଟିପୂର୍ଣ୍ଣ ଶିକ୍ଷାପଦ୍ଧତି ମଧ୍ୟ
ବିଶୃଙ୍ଖଳାର କାରଣ। ଏହା ଛାତ୍ରମାନଙ୍କୁ ଅନିଶ୍ଚିତ ଭବିଷ୍ୟତ ଦେଖାଉଛି। ଶିକ୍ଷାଲାଭ ପରେ ନିଯୁକ୍ତିର କୌଣସି ନିଶ୍ଚୟତା ନାହିଁ।

SubQuestion No : 80

Q.80 “ଅଶ୍ଳୀଳ”ର ସମାନାର୍ଥକ ଶବ୍ଦ ବାଛନ୍ତୁ।

Ans A. ମାନ୍ୟ

B. ସୁସ୍ଥ

C. ଶାନ୍ତ

D. ଅଭଦ୍ର

Question Type : MCQ
Question ID : 4410091481881
Option 1 ID : 4410095854571
Option 2 ID : 4410095854569
Option 3 ID : 4410095854572
Option 4 ID : 4410095854570

Status : Answered
Chosen Option : D

Q.81 In context of Editing Worksheet Data in MS Excel 2021, match Actions in Column A
with their correct descriptions in Column B:

Column A Column B
1. Double-click a cell a) Deletes the contents from a selected cell

2. Backspace/Delete Key b) Activates in-cell editing mode for modifying existing data

3. Undo (Ctrl + Z) c) Cancels or reverses the last performed action

Ans A. 1–b, 2–c, 3–a

B. 1–b, 2–a, 3–c

C. 1–c, 2–b, 3–a

D. 1–a, 3–b, 2–c

Question Type : MCQ
Question ID : 4410091468653
Option 1 ID : 4410095802540
Option 2 ID : 4410095802538
Option 3 ID : 4410095802541
Option 4 ID : 4410095802539

Status : Answered
Chosen Option : D
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Q.82 Which sequence of steps is the standard way to open an existing PowerPoint
presentation file from within the Microsoft PowerPoint application?

Ans A. Click the Insert tab, then select New Slide

B. Click the Review tab, then select Compare.

C. Press the F5 key on the keyboard.

D. Click the File tab, then select Open.

Question Type : MCQ
Question ID : 4410091430993
Option 1 ID : 4410095652286
Option 2 ID : 4410095652287
Option 3 ID : 4410095652285
Option 4 ID : 4410095652284

Status : Answered
Chosen Option : A

Q.83 Which desktop background option may distort the image if its aspect ratio differs
from the screen?

Ans A. Stretch

B. Center

C. Fit

D. Fill

Question Type : MCQ
Question ID : 4410091450086
Option 1 ID : 4410095728854
Option 2 ID : 4410095728855
Option 3 ID : 4410095728853
Option 4 ID : 4410095728852

Status : Answered
Chosen Option : D

Q.84 Which feature in MS Word helps users automatically identify and correct
spelling or grammar mistakes in a document?

Ans A. AutoCorrect and Spelling & Grammar

B. Track Changes

C. Mail Merge

D. AutoRecover

Question Type : MCQ
Question ID : 4410091416325
Option 1 ID : 4410095593998
Option 2 ID : 4410095594000
Option 3 ID : 4410095593999
Option 4 ID : 4410095593997

Status : Answered
Chosen Option : C
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Q.85 When sending confidential attachments via email, the most secure approach is to:

Ans A. Compress the file without applying a password

B. Divide the file into parts and send through multiple emails

C. Simply rename the file before sending

D. Encrypt the file before attaching it

Question Type : MCQ
Question ID : 4410091453081
Option 1 ID : 4410095740631
Option 2 ID : 4410095740630
Option 3 ID : 4410095740629
Option 4 ID : 4410095740628

Status : Answered
Chosen Option : B

Q.86 Which of the following statements correctly explains the role of WhatsApp as a
social media platform in modern communication?

Ans A. WhatsApp is an instant messaging application that enables users to exchange text, voice, video,
and documents in real time over the internet.

B. WhatsApp is a platform designed only for business advertising and has no personal
communication features.

C. WhatsApp is a blogging site that allows users to publish long-form articles and website links.

D. WhatsApp is a video-only sharing platform primarily used for entertainment purposes.

Question Type : MCQ
Question ID : 4410091477824
Option 1 ID : 4410095838630
Option 2 ID : 4410095838632
Option 3 ID : 4410095838631
Option 4 ID : 4410095838629

Status : Not Answered
Chosen Option : --

Q.87 What is the full form of the acronym CPU, which is considered the main component
that executes instructions in a computer system?

Ans A. ​Computer Peripheral Unit

B. Central Processing Unit

C. Control Program Update

D. Common Power Utility

Question Type : MCQ
Question ID : 4410091423417
Option 1 ID : 4410095622491
Option 2 ID : 4410095622490
Option 3 ID : 4410095622492
Option 4 ID : 4410095622489

Status : Answered
Chosen Option : B
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Q.88 In the context of Windows 11 and Office 2021, which of the following best represents
an application of a computer?

Ans A. Accessing BIOS settings

B. Installing device drivers

C. Formatting a hard drive

D. Sending emails using Outlook

Question Type : MCQ
Question ID : 4410091417108
Option 1 ID : 4410095597345
Option 2 ID : 4410095597344
Option 3 ID : 4410095597346
Option 4 ID : 4410095597343

Status : Answered
Chosen Option : A

Q.89 In the context of Text Selection in MS Word 2021, match the actions in Column A with
their correct descriptions in Column B:

Column A Column B
1. Ctrl + A a) Duplicates the selected text and stores it in the clipboard

2. Ctrl + C b) Removes the selected text and saves it temporarily to the clipboard

3. Ctrl + X c) Inserts the copied or cut text at the current insertion point

4. Ctrl + V d) Highlights all the content in the document

Ans A. 1–b, 2–c, 3–d, 4–a

B. 1–d, 2–a, 3–b, 4–c

C. 1–c, 2–d, 3–a, 4–b

D. 1–a, 2–b, 3–d, 4–c

Question Type : MCQ
Question ID : 4410091468395
Option 1 ID : 4410095801460
Option 2 ID : 4410095801457
Option 3 ID : 4410095801458
Option 4 ID : 4410095801459

Status : Answered
Chosen Option : D
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Q.90 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ  କମ୍ବି ନେସନ ସୂଚନା ସୁରକ୍ଷାର ସର୍ବୋଚ୍ଚ ସ୍ତର (highest level of information
protection) ପ୍ରଦାନ କରିଥାଏ?

Ans A. ଭେରୀଫାଏ ହୋଇ ନ ଥି ବା ପବ୍ଲି କ ୱାଇ-ଫାଇ ବ୍ୟବହାର କରିବା

B. ଷ୍ଟ୍ରଙ୍ଗ ପାସୱାର୍ଡ ଏବଂ ରେଗୁଲାର ବ୍ୟାକଅପ

C. ସ୍କ୍ରି ନ ରିଜୋଲ୍ୟୁସନ ନିୟମିତ ଭାବରେ ବଦଳାଇବା

D. ଡିସ୍କ ଫର୍ମାଟିଙ୍ଗ ଏବଂ ଟେମ୍ପୋରାରୀ ଫାଇଲ ଡିଲେଟ କରିବା

Question Type : MCQ
Question ID : 4410091416153
Option 1 ID : 4410095593316
Option 2 ID : 4410095593313
Option 3 ID : 4410095593315
Option 4 ID : 4410095593314

Status : Not Answered
Chosen Option : --

Q.91 In context of creating text number and data series in MS Excel 2021, match the
following methods with their corresponding descriptions :

Column A Column B
1. AutoFill Handle a) Automatically continues number sequences or patterns when

dragged

2. Flash Fill b) Detects and completes text patterns based on the existing data
entries

3. Fill Series Dialog
Box

c) Allows users to define custom options for creating linear, growth,
or date series

4. Ctrl + Drag d) Duplicates data or extends a sequence by dragging while holding
Ctrl

Ans A. 1–b, 2–a, 3–d, 4–c

B. 1–d, 2–b, 3–c, 4–a

C. 1–c, 2–d, 3–a, 4–b

D. 1–a, 2–b, 3–c, 4–d

Question Type : MCQ
Question ID : 4410091468619
Option 1 ID : 4410095802315
Option 2 ID : 4410095802316
Option 3 ID : 4410095802317
Option 4 ID : 4410095802314

Status : Answered
Chosen Option : B
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Q.92 In context of Inserting and Deleting - Row Column in MS Excel 2021, match the
following actions with their corresponding shortcuts or methods for inserting and
deleting rows/columns:

Action Shortcut/Method
1. Insert a new row above the
selected row

a) Press Ctrl + Shift + "+" to add a new row above
the current selection

2. Insert a new column to the left
of the selected column

b) Use Ctrl + Spacebar to select the column, then
press Ctrl + "+" to insert a new one

3. Delete the selected row c) Press Ctrl + "-" to remove the currently selected
row

4. Delete the selected column d) Use Shift + Spacebar to select the row, then press
Ctrl + "-" to delete it

Ans A. 1–d, 2–c, 3–b, 4–a

B. 1–b, 2–a, 3–d, 4–c

C. 1–a, 2–b, 3–c, 4–d

D. 1–a, 2–b, 3–d, 4–c

Question Type : MCQ
Question ID : 4410091468664
Option 1 ID : 4410095802593
Option 2 ID : 4410095802591
Option 3 ID : 4410095802590
Option 4 ID : 4410095802592

Status : Answered
Chosen Option : C

Q.93 Which option creates a new empty presentation in MS PowerPoint 2021?

Ans A. Insert → New Slide ​​​​

B. File → New → Blank Presentation

C. File → Import

D. File → Open

Question Type : MCQ
Question ID : 4410091459795
Option 1 ID : 4410095767346
Option 2 ID : 4410095767343
Option 3 ID : 4410095767345
Option 4 ID : 4410095767344

Status : Answered
Chosen Option : D
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Q.94 What is the primary function of the collaborative "Comments" system in Google
Docs?

Ans A. allow users to save the file

B. allow users to secure the file

C. allow users to modify the file

D. allow users to provide feedback

Question Type : MCQ
Question ID : 4410091478611
Option 1 ID : 4410095841773
Option 2 ID : 4410095841771
Option 3 ID : 4410095841774
Option 4 ID : 4410095841772

Status : Not Answered
Chosen Option : --

Q.95 Which features support the manual or automatic categorization of emails for
enhanced long-term organization?

Ans A. Composing and Sending

B. Specify Message Priority

C. Request a Delivery Receipt

D. Labels or Folders

Question Type : MCQ
Question ID : 4410091478573
Option 1 ID : 4410095841623
Option 2 ID : 4410095841625
Option 3 ID : 4410095841626
Option 4 ID : 4410095841624

Status : Answered
Chosen Option : A

Q.96 F5 key in Windows in used for:

Ans A. Save as

B. Save

C. Delete

D. Refresh

Question Type : MCQ
Question ID : 4410091436554
Option 1 ID : 4410095674829
Option 2 ID : 4410095674828
Option 3 ID : 4410095674830
Option 4 ID : 4410095674827

Status : Answered
Chosen Option : D
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Q.97 Which cache level is typically shared among all cores in a multi-core CPU?

Ans A. Virtual Cache

B. L2 Cache

C. L3 Cache

D. L1 Cache

Question Type : MCQ
Question ID : 4410091445458
Option 1 ID : 4410095710412
Option 2 ID : 4410095710410
Option 3 ID : 4410095710411
Option 4 ID : 4410095710409

Status : Not Answered
Chosen Option : --

Q.98 What is the main function of the 'Rehearse Timings' feature in Microsoft PowerPoint
2021?

Ans A. to speed up the transition effect

B. to automatically insert and update dynamic information

C. to ensure your presentation data is always up-to-date

D. to practice and record the pace of a presentation

Question Type : MCQ
Question ID : 4410091478526
Option 1 ID : 4410095841440
Option 2 ID : 4410095841442
Option 3 ID : 4410095841439
Option 4 ID : 4410095841441

Status : Not Answered
Chosen Option : --

Q.99 In Microsoft Word, when text appears uneven or irregularly spaced even
after applying Justify alignment, the most common cause is that:

Ans A. Track Changes mode is turned on

B. Hyphenation is not enabled

C. Font sizes are mismatched within the paragraph

D. Page margins are incorrectly set

Question Type : MCQ
Question ID : 4410091425450
Option 1 ID : 4410095630403
Option 2 ID : 4410095630404
Option 3 ID : 4410095630405
Option 4 ID : 4410095630406

Status : Answered
Chosen Option : C
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Q.100 Which characteristic of RAM (Random Access Memory) makes it an unsuitable
primary storage location for system firmware (like the BIOS) and requires the
computer to quickly reload the operating system every time it is turned on?

Ans A. ​It is volatile.

B. ​It is non volatile.

C. It is read only.

D. It has sequential access.

Question Type : MCQ
Question ID : 4410091424457
Option 1 ID : 4410095626679
Option 2 ID : 4410095626680
Option 3 ID : 4410095626681
Option 4 ID : 4410095626682

Status : Answered
Chosen Option : B
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